TRACEPRO"” TUTORIAL

Integrating Sphere

Requirements
Models: None
Properties: None

Editions: TracePro Standard and Expert

Introduction

An integrating sphere is an excellent tool for producing a highly uniform distribution of light. Light rays are
introduced into the interior of a spherical shell, where they repeatedly scatter until they escape through a
circular exit port cut through the shell. This tutorial will show you how to:

Create the integrating sphere with a circular exit port.

Create a detector surface outside the exit port.

Add a surface property to the TracePro property database.
Assign the new surface property to the integrating sphere.
Perform a simple raytrace with and without importance sampling.
View the results on an irradiance map, as well as in tables.
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TRACEPRO"” TUTORIAL Integrating Sphere

Creating Two Spheres

You will create the spherical shell by Boolean subtraction using two concentric solid spheres. The exit port will be created by
another Boolean subtraction using a circular cylinder to cut away part of the spherical shell.

From the Insert menu select Primitive Solid to activate the Insert Primitive Solids dialog box Click the Sphere tab.
Change the value in the Radius box to 50.

Click Insert to create the inner sphere.

Press the Zoom All button or select the View | Zoom | All menu to see the new object

Change the value in the Radius box to 52 and click Insert again to create the outer sphere.

Move the Insert Primitive Solids dialog box out of the way (it can be left open because it is “modeless”).

You can now save the model as demosphere.oml
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TRACEPRO"” TUTORIAL Integrating Sphere

Creating the Spherical Shell

The spherical shell is made by subtracting the inner sphere from the outer sphere.

I, Select the Edit|Select | Object mode or press on the Select Object tool.

2. Click the silhouette (outline) of the larger sphere to select it first. Its silhouette will be highlighted.

3. Click the silhouette (outline) of the smaller sphere to while pressing the Ctrl key to add the smaller sphere to the selection.
Both silhouettes will be highlighted.

4. Select Edit| Boolean |Subtract or click the Subtract button on the toolbar. The Boolean subtract* command executes
automatically as soon as the command is selected. The next figure shows the new contents of the model window. If you
have made a mistake, click the undo button located on the toolbar.

fi: Model:[Demosphere]

+\/EM

%

Model Source | Radiance

*Note: In the Boolean subtraction operation, the second object selected (the tool) cuts away material from the first
object (the blank) wherever the two intersect. After this operation, the modified first object is kept, while the second
object is deleted automatically.
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TRACEPRO‘E‘ TUTORIAL Integrating Sphere

Add the Exit Port

The integrating sphere needs an exit port to allow light to leave the object. The exit port will be added by subtracting a cylinder from

the shell.

I, Click the Cylinder/Cone tab in the Insert|Primitive Solids dialog box. Make sure that Cylinder (not cone) is selected,
and make sure that “Elliptical Base” is not selected.

2. Change the Y value of the Base to —45. Change the Major R value of the Base to 8. Change the X value of the Base

Rotation to 90. Change the Length to 10.The Insert Primitive Solids dialog box should now Look like the figure below.

Click Insert to create the cylinder.

4. Select the spherical shell and add the cylinder with a Shift+Click. Click the Boolean Subtract button to perform another
Boolean subtraction, it will cut material from the spherical shell, creating the circular exit port.

w
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TRACEPRO"” TUTORIAL Integrating Sphere

Naming Objects and Surfaces

The system tree can be used to add descriptive names to objects and surfaces.

[. Inthe system tree there should now be only one object. Rename this object to "Integrating Sphere". To rename an object,
highlight the original name and type in a new name. Note that objects and surfaces being renamed are highlighted in the model
window.

2. Rename the inner and outer surfaces of the integrating sphere in the system tree to “Inner Surface” and “Outer Surface’,
respectively. Rename the cylindrical surface of the exit port to “Exit Port Surface.”

3. Click the Save button on the toolbar (or select File | Save) to save the model at this stage.

4. Click the Iso View | button on the toolbar to get a better view of the circular exit port. The following figure shows the new
contents of the model window with the system tree expanded.

fi: Model:[Demosphere]
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TRACEPRO"” TUTORIAL Integrating Sphere

Creating the Detector Surface

The detector surface will be the top surface of an 8mm diameter thin circular disk located opposite the exit port. To create the

detector surface:

I. Click the YZ view button on the toolbar to change views back to the original.

2. Click the Cylinder/Cone tab in the Insert|Primitive Solids dialog box. Make sure that Cylinder (not cone) is selected,
and make sure that “Elliptical Base” is not selected.
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b

Change the Y value of the Base to —58. Keep the Major R value of the Base equal to 8. Change the Length value to 1.
Click Insert to create the disk, and close the Insert | Primitive Solids dialog box.

Rename this new object “Circular Disk”. Rename its surfaces to “Outer Edge”, “Detector Surface”, and “Bottom Surface”.
Click the Zoom Al button on the toolbar to rescale the objects in the model window.
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TRACEPRO‘@‘ TUTORIAL Integrating Sphere

Adding a Surface Property to the Database

TracePro has a Surface Property Editor that can be used to add new surface properties to the database or modify the existing

ones. You will use this editor to define a new property named “Lambertian” that scatters light diffusely (in a Lambertian distribution)

and absorbs 9% of the incident light. TracePro enforces conservation of energy, which means that the sum of the absorbed, re-

flected and transmitted light must equal the incident light at a surface. Whenever surface property data are created or modified they

are checked for conservation of energy. To assist the user, TracePro offers the “Solve for" command that can be used for automatic

calculation of surface properties to assure conservation of energy. You will use the “Solve for* command to correct the Lambertian

value for BRDF A. To define the new surface property:

I. Point to From the Define menu, select Edit Property Data|Surface Properties. This will open the Surface Property
Editor. Click Add Property.

2. Enter Lambertian into the Surface Property Name field, select ABg scatter model and click the OK button. This will

return you to the Surface Property Editor dialog box with default numerical values in the fields.

Click the absorptance data field and enter the value 0.01 into the field.

4. From the Solve for drop-down list click BRDF to calculate the correct value for BRDF A (=.346639) and automatically insert
it into the field, as shown below.

5. From the File menu click Save and then Close to save the surface property data to the TRACEPRO.MDB database file and
then return to the model window.

w
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Note: The Lambertian surface property values have only been defined for a single angle of incidence. TracePro will use these
values for all angles unless additional angles are defined, in which case TracePro will use linear interpolation to obtain data for
intermediate angles.
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TRACEPRO"” TUTORIAL

Assigning the New Surface Property to the Integrating Sphere

Integrating Sphere

At this point the necessary geometrical objects have been created and Lambertian has been added to the surface property database.

The next step is to assign the Lambertian surface property to the inside of the integrating sphere, as follows:
Select the inner surface of the integrating sphere by clicking its name in the system tree.

From the Define menu select Apply Properties.
Click the Surface tab.

From the Surface Property Name drop-down list select Lambertian.
Click the Apply button.

Check in the system tree that the Inner Surface of the Integrating Sphere was assigned the Lambertian surface property.
Close the Apply Properties dialog box.

No AW —
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=R nnet 5 e
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TRACEPRO‘E‘ TUTORIAL Integrating Sphere

Setting Raytrace Thresholds

Before tracing any rays you will redefine the flux threshold. The default value is 0.05, which means that as rays bounce around and
split into more rays, the new rays with less than 5% of the starting flux will no longer be traced. In order to generate a significant
number of rays exiting the integrating sphere you should decrease this threshold to 0.0005

I. From the Raytrace menu select Raytrace Options.

2. Click the Thresholds tab and enter a value of 0.0005 for Flux Threshold as shown.

3. Click Apply and close the Raytrace Options dialog box.

1. Model:[Demosphere]

W Inteqgrating Sphere

. Circular Disk M Raytrace Options |L|-7 |§|

Simulation & Output I Advanced | /'f—’—'—_‘kﬂ

Options | wWavelengths Thresholds

Flu Threshold: I.DDDS

[fractional walue of starting flu] N

Intercept Limit
Total Intercepts: |1000
Total Scatters: | 1000
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AN

Optical Scatters: (1000

Set Defaults
i
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TRACEPRO"” TUTORIAL Integrating Sphere

Tracing Rays

In this example you will trace rays from a circular grid. The actual number of rays traced will be determined when you specify a Rings
value for the grid, i.e. the number of rings making up the circular grid of starting points. In this case you will use a Rings value of 3,
which corresponds to 19 starting rays. The rays will start inside the sphere at a 45° angle.

From the Define menu select Grid Source, bringing up the Grid Source dialog box.

In the Source Tree, select Grid Source |

With Annular selected for the Grid Boundary enter 5 for the Outer radius, and keep the Inner radius equal to 0.
With Circular selected for the Grid Pattern enter 3 for the Rings value.

For the Origin change the Z value to 44, leaving the X and Y components equal to 0.

For the Normal Vector change the Y and Z component values to | and -1, respectively, leaving the X component
equal to 0.

Leave the Up vector X, Y, and Z components equal to 0, I, and 0, respectively.

The Grid Source dialog box should now appear as follows:

Click the Modify button. then close the Grid Source dialog box.

O Click the Trace Rays icon to start an audit of the model, followed by the specified raytrace. A total of 19 rays will be traced.

oA W —

S 0@
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The figure shows the Grid Source dialog box and the model window after the Grid Raytrace has finished. Note how the
interior of the integrating sphere is filled with rays, with a few rays escaping through the exit port.
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TRACEPRO"” TUTORIAL Integrating Sphere

Setting the Irradiance Map Options

To create an irradiance map to view the flux incident on the detector surface, do the following:

|. From the Analysis menu select Irradiance/ llluminance Options and make the following entries in the dialog box.
2. For Map Type select Incident in the Rays to Plot drop-down list.

3. For Display select Grayscale on Black from the Color Map drop-down list.

4. Click the “Automatically calculate Normal and Up Vectors’ box.

5. The Irradiance Options dialog box should match the dialog shown:

6. Click Apply and move the Irradiance Options dialog box out of the way.

1. Model:[Demosphere]
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TRACEPRO® TUTORIAL Integrating Sphere

Viewing the Irradiance Map

An Irradiance Map can be displayed for any surface in the mode by selecting a desired surface and open the plot.
I. Click the object Circular Disk to get the drop down

2. Click to select the Detector Surface in the system tree.

3. From the Analysis menu select Irradiance/llluminance Maps to create the irradiance map. It is shown in the following

figure.

To view these results in false color:

I.  Select Color (rainbow) on Black from the Color Map drop-down list in the Irradiance/llluminance Options dialog

box and click Apply.
2. Close the Irradiance/llluminance Options dialog box.

fi: TracePro Standard - [Inradiance/llluminance Map:[Demosphere.oml]]
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TRACEPRO‘@‘ TUTORIAL Integrating Sphere

Viewing the Incident Ray Table

To view a table of the rays striking the detector surface, do the following:

I. Close the Irradiance Map and go back to the model.

2. If the detector surface is not selected (highlighted) in the system tree, select it now by clicking on it in the system tree or the
model window.

3. From the Analysis menu select Incident Ray Table.

The following figure shows a portion of the table that should be obtained. Note that 6 rays are listed, corresponding to the 6 rays
shown in the Irradiance/llluminance Map.

fi: TracePro Standard - [Incident Ray Table:[Demosphere.oml(]] = B[]
:l File Edit View Define Raytrace Analysis Reports Tools Macros Window Help - 8 x

D8] & #[%|@| ©|~| w|ole| ] x|¥ || OBS0] <% @ #lew| ] 2]

s|s|a|ala|RE|a] | dul=lo] =] ] »[H]| pale] ] p] Bl=][T]] L% |
Circular Disk Detector Surface

Ray Mumber | Wavelength | Source Start Ray Ray Node Type History Flux % Pos, ¥ Pos, Z Pos., ¥ Vec, ¥ Ve, 2 Yec,

1 0.5461 Grid Source 1 |6 142 RandRef! 0.244365 -2.08 -85 -0.613079 -0.140766 -0.954436 -0.10822

2 0.5461 Grid Source 110 346 RandRef| 0.0315142 277141 -58 3.01829 0.141756 -0.9887%6 0.0467772

3 0.5461 Grid Source 1|11 179 RandRef! 0.168822 -1,46556 -58 -4, 45982 -0.18589 -0.913261 0.382491

4 0.5461 Grid Source 1|12 383 Randref! 0.0217275 -3.72892 -85 2.82974 -0.233183 -0.972419 0.00515891

5 0.5461 Grid Source 1 |15 378 RandRef! 0.0228472 1.57134 -85 Z.46595 -0.381271 -0.915891 0.125599

6 0.5461 Grid Source 1 |16 262 RandRef| 0.0733079 -3.79376 -58 -6,56832 -0.219203 -0.631866 -0.743418
For Help, press F1 %:0.0000 ¥:42. 1007 2:-74.9858 milimeters %:0,0000 ¥:56.8020 Z:-43.2419 milimeters UM )

search

Corporation

www.lambdares.com

Page 13



TRACEPRO"” TUTORIAL Integrating Sphere

Adding Importance Sampling

“Importance sampling” is a technique in which scattered (and diffracted) rays are generated and transmitted towards specific “targets”
in the optical system that are considered “important.” This improves sampling by increasing the number of rays going in a direction
that is important to you. This technique can be especially helpful in stray light analysis where the attenuation of incident light may be
very great. In this tutorial you will add one importance sampling target to the model. Its location, orientation, shape, and size will be
specified to match the exit port. This will increase the number of rays hitting the detector surface, while the flux of each ray will be
smaller. The same total flux will hit the detector surface as before, but spread over many more rays, giving a better picture of the
distribution of light at the detector surface.

Go back to the model.

Select the Inner Surface of the Integrating Sphere.

From the Define menu select Apply Properties.

Click the Importance Sampling Tab in the Apply Properties dialog box.

For Target | change the Target Center Y value to -49.355851, change the Normal Vector to (0,1,0), the Up Vec-
tor to (0,0,1), and change the Outer Radius value to 8 as shown.

Click Apply.

Check the system tree to verify that an Importance Target has been defined on the Inner Surface of the Integrating
Sphere.

8. Close the Apply Properties dialog box.

U W —

No

fi: TracePro Standard - [Model:[Demosphere.oml]]
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TRACEPRO® TUTORIAL Integrating Sphere

Raytrace with an Importance Target

I. Select Raytrace | Trace Rays to start the raytrace.

The figure shows the grid raytrace with importance sampling turned on.

TracePro Standard - [Model:[Demosphere.oml]]
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TRACEPRO® TUTORIAL Integrating Sphere

Irradiance Map with Importance Sampling

Now you can view the updated irradiance map.

| Click to select the Detector Surface in the system tree.

2. From the Analysis menu select Irradiance/llluminance Maps.

3. The following figure shows the resulting irradiance map. Note that many rays have now intercepted the detector surface, and
they are uniformly distributed over the surface.

fi: TracePro Standand - [Inradiance/llluminance Map:[Demosphere.oml]]
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TRACEPRO® TUTORIAL Integrating Sphere

Arranging Views

Sometimes it is useful to display multiple views simultaneously. For example, with the model, system tree and irradiance map views
open together, you can select different surfaces on the system tree and automatically see the flux incident on them as well as their
highlighted location in the model view. You can also include the ray histories view which will also update as you choose different
surfaces. To arrange these views do the following

I. From the Window menu select Tile Vertical or use the tile vertical button.

2. You can Resize the different windows to your liking.

fi- TracePro Standard E]@ =,
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